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INTRODUCTION 
 
 

This lab manual is designed to be used in the context of an introductory course in Acoustic 
Phonetics. It is based on the software Praat, created by Paul Boersma and David Weenink 
(www.praat.org), and covers measurement techniques useful for basic acoustic analysis of 
speech. LAB 1 is an introduction to Praat: the layout of various displays and the basic functions. 
LAB 2 focuses on fundamental frequency, harmonics and formants, and on how to measure these 
using different displays. The next three labs guide students through taking acoustic 
measurements typically relevant for vowels (LAB 3), sonorants (LAB 4) and obstruents (LAB 5). 
LAB 6 discusses ways of measuring phonation. LAB 7 focuses on stress, pitch-accent, and tone. 
Labs 8 and 9 bring together the material from previous labs in an exploration of cross-dialectal 
(LAB 8) and cross-linguistic (LAB 9) differences in speech. Finally, LAB 10 introduces speech 
manipulation and synthesis techniques. Each lab includes a set of questions designed to ensure 
that the user understands the measurements taken as well as the values obtained for these 
measurements. These questions are repeated in the worksheet at the end of the lab, which can 
serve as a way of recapitulating the content of the lab. 
 
The lab manual is a work in progress, and the authors, Sonya Bird and Qian Wang, would 
appreciate any feedback you may have on it. Thank you! 
 
Sonya Bird sbird@uvic.ca 
Wang Qian wangqian@uvic.ca 
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LAB 1 – EXPLORING PRAAT 
 
GOAL OF LAB 1 
The goal of this first lab is to explore some of the basic features of PRAAT (www.praat.org), 
which we will be using for speech analysis throughout the term. You will learn to make 
recordings, bring up visual displays of these recordings (waveforms and spectrograms), segment 
and label various components of these recordings, and export the visual displays into a word 
document. The skills you learn today will be useful for your lab work throughout the remainder 
of this course and beyond…  
 
1. Open Praat: double click on the following icon (Fig. 1.1): 

Figure 1.1 Praat icon 
 
2. Get to know the Praat layout (Fig. 1.2) 

Figure 1.2 Praat layout
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TIP The tools you see in the Analysis and Synthesis Tool Panel (see Fig. 1.2 above) are 
specific to the highlighted object(s) in the list. For example, the tools that are listed for a 
sound object are different from that for a Textgrid object1. When you first open Praat, 
there will be nothing in your object list. As a result, nothing will show up in your 
Analysis and Synthesis Tool Panel. 

 
3. Record the sentence: “My name is [first-name] [last-name]” 
 

o In the main menu of the Objects window (see Fig. 1.2): 
o New > Record mono Sound (sampling rate: 44 100 Hz) (Fig. 1.3) 
o Make sure the volume bar is fluctuating as you record – if it isn’t, you’re not recording; 

if you don’t see the volume bar at all, you’re not speaking loudly enough. 
o Watch out for clipping (Fig. 1.4): if your recording level is too high and you go into the 

red on the volume bar, you’ll end up with what is called a “clipped” signal – this is very 
bad for speech analysis! 

o Give the recording a name (in the box below “Save to list”) 
o Save to list 

 

 
Figure 1.3 Recording a mono Sound 

 

                                                 
1 What is a Textgrid object? See step 8 below. 
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Figure 1.4 Clipped signal 
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4. Open the sound file in the Edit window:  
 

o In the Objects window (see Fig. 1.2), highlight the sound file you’ve just recorded. 
o Click Edit on the “Analysis and synthesis tools” panel (see Fig. 1.2).  

 
When you first open a sound file in the Edit window, it may seem a bit of a mess.  You can see 
blue vertical lines in the waveform, and lines of red dots and a blue line in the spectrogram (see 
Fig. 1.5). You can tidy up the visual display by doing the following: in the menu of the Edit 
window: 

o Pulses > Show pulses (click on this to unselect it) 
o Formants > Show formants (click on this to unselect it) 
o Pitch > Show pitch (click on this to unselect it) 

 
Two things are being displayed now in the Edit window: the waveform on the upper level and 
the spectrogram on the lower level.  
 

 
Figure 1.5 A crowded edit window 
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TIP Here are some common manipulations you will find useful: 
Selecting a portion of the sound file and measure the duration of the portion 

o To select a portion of the sound file, place the cursor on the starting point on the waveform 
or spectrogram and drag the mouse over the portion you are interested in.  

o The number in black at the top and bottom of the display indicates the duration of the 
selection. The two red numbers on each side of the selection (on the top only) indicate the 
starting and ending time of the selection (see Fig.1.6). 

 
Zooming into a portion of the sound file 

o To zoom into a specific portion of the sound file, select it first and click “sel” in the zoom 
options panel (see Fig. 1.6).  

o You can also use the “in” and “out” buttons in the zoom options panel to zoom in or zoom 
out within the sound file. This will zoom the file around the center point of the window 
display, regardless of where your cursor is. 

 
Listening to a sound file 

o In the Edit Window, you can listen to the sound file or a portion thereof by clicking on one 
of the panels at the bottom of the display (Fig. 1.6). 

 
5. Extract [first-name last-name] 
 

o Select the portion that corresponds only to your first and last name (see Fig. 1.6) 
o File > Extract Selection (The extracted selection will show up as a entry (‘sound untitled’) 

in the Praat objects window) 
o Close Edit window 

Figure 1.6 Editing a sound file 

 

Edit 
win

Zoom options 

Click on the panel to 
listen to this section 
of the sound file 

Number in black = 
Duration of the 
selection 

Number in red = 
Starting and ending 
time of the selection Highlighted 

section of the 
sound file 



LAB 1 – EXPLORING PRAAT 
 

6 

6. Rename the extracted file (‘sound untitled’ in the Praat objects window) 
 

o In the Objects window, highlight ‘sound untitled’ 
o Click Rename below the object list 

 
Q1: What information should you include when giving your sound file a name? 
 
7. Save the new sound file on the desktop: 

o Highlight the file in the object list 
o Write > Write to WAV file…  (this is the most widely acceptable extension) 
o Select the desktop as the save-to location 

 
8. Create a textgrid  
 
Textgrids let you label or annotate the spectrogram (and sound file) – they are particularly 
helpful for acoustic analysis, to keep track of where you’ve taken measurements, etc. 
 

o In the Praat Objects window, highlight the newly renamed file (see step 6) 
o Annotate > To TextGrid…  (see Fig. 1.7) 
o Create two tiers (this will be enough for our purposes): All Tier names: word segment2 

 
Figure 1.7 Creating a textgrid 

 

                                                 
2 This creates 2 tiers, one with the name of ‘word’ and the other with the name of ‘segment’. Ignore the second line 
in the TextGrid naming window “Which of these are point tiers”. This is irrelevant at the present stage. 
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9. Open the sound file and textgrid together: (see Fig. 1.8) 
 
In order to segment and/or label a sound file, you have to open the sound file TOGETHER with 
its textgrid file. 
 

o Hold down Ctrl and click on each file to highlight them both 
o Edit 

Figure 1.8 Opening a textgrid file with its corresponding sound file 
 
In your display you should now see the waveform (top), the spectrogram (middle) and the 
textgrid (bottom) corresponding to your sound file (see Fig. 1.9). We will talk about waveforms 
and spectrograms in detail later on. 
 
10. Segment the file (see Fig. 1.9) 
 
In the sound file, identify your first name and last name. Use the following steps to segment each: 
 

o To find each name on the spectrogram, listen to the sound file and look at the spectrogram 
– these should give you hints as to where each name starts and ends. It may help to zoom 
into small chunks of the sound file and listen those. 

o Place the cursor at the beginning of the name on the spectrogram/waveform (not on the 
Textgrid tier). A boundary line will show up. 

o Click in the little circle at the top of the word tier in the Textgrid to create a boundary 
(Fig.1.9). 

 

Highlight both the sound 
file and the textgrid file 

Click Edit to open both 
files in Edit window 
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o To remove a boundary that you have made, 
o Highlight the boundary 
o Go to Boundary > Remove  OR click Alt+backspace 

o To move a boundary,  
o Highlight the boundary by clicking on it (it should go red) and drag it.  

 
 
11. Label the intervals (see Fig. 1.9) 
 

o Select/highlight the target interval by clicking between two boundaries, the selected the 
interval should go yellow. 

o To input or change the text in an interval, edit in the Textbox above the spectrogram (See 
Fig 1.9).  

o Give each interval you create a name ([first name] or [last name]) 
 

Figure 1.9 Segmenting and labeling 
 
12. Follow steps (10) and (11) to segment your [first name + last name] into segments. 
 
 
TIP To use phonetic symbols in your segment tiers, 

o In the TextGrid editing window, go to Help > Phonetic symbols 
o From here you can see what keystrokes you need to create special fonts (using them is not 

recommended because they end up looking a bit wonky… ) 
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Q2: How can you tell where one word ends and another word begins? 
 
Q3: Do you notice any patterns in terms of how different sounds look visually, on either the 

waveform or the spectrogram? 
a. Which sounds have the highest amplitude and how can you tell? 
b. How do sounds of different sonority (e.g. stop vs. fricative) look on the spectrogram? 

 
13. Save your textgrid onto the desktop:  
 

o File > Write TextGrid to textfile…  
 
14. Export your labeled waveform and spectrogram to Word (see Fig. 1.10): 
 

o Maximize the Edit window: click on the little square at the top right of your Edit window 
o Hit PrtSc (“Print Screen”) on your keyboard3. Nothing would happen on your screen at this 

point. 
o Open Word, and provide a prose introduction to the image you are about to paste in: e.g. 

“Figure 1 is a waveform and spectrogram of my name” 
o Hit Ctrl+V to paste the Praat image into your word document. 
o Give your Figure a number and title below the image (see Fig. 1.10)  

 

 
Figure 1.10 Example of Word output 

                                                 
3 Note: this works on a PC. On a MAC: command-shift-3:. By doing this, you are actually copying what you see on 
the screen to a clipboard, although it seems that nothing has happened. 
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15. Save the file: you must print it out and bring it to the next class. 
 
If you complete all of these steps, you should end up with a word file with an image of the 
labeled waveform/spectrogram corresponding to your name, as in Fig. 1.10.  You can save this 
file, and your Praat files (sound and textgrid) by e-mailing them to yourself or copying them onto 
a flash drive (memory stick). 
 
 
 

You must hand in your worksheet at the end of the lab. 
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LAB 1 – EXPLORING PRAAT – WORKSHEET 
 
Don’t forget – You must hand in the word document you created in the next class. 
 
 
Q1: What information should you include when giving your sound file a name? 
 
 
 
 
 
 
 
 
Q2: How can you tell where one word ends and another word begins? 
 
 
 
 
 
 
 
 
 
Q3: Do you notice any patterns in terms of how different sounds look visually, on either the 

waveform or the spectrogram? 
a. Which sounds have the highest amplitude and how can you tell? 
b. How do sounds of different sonority (e.g. stop vs. fricative) look on the spectrogram? 
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LAB 2 – THE SOURCE-FILTER MODEL OF SPEECH:  
FUNDAMENTAL FREQUENCY, HARMONICS AND FORMANTS 

 
GOAL OF LAB 2 
The goal of this lab is to explore the basic acoustic components of (sonorous) speech sounds: 
FUNDAMENTAL FREQUENCY, HARMONICS, and FORMANTS. These components create the acoustic 
signal associated with speech – understanding them is crucial to understanding what we actually 
hear, when we hear speech.  
 
RECORDING 
o Record yourself saying the vowel [æ] at three different pitches: low, mid, high – try to get 

the biggest range in pitch you can ((if you can’t remember how to do this, refer to LAB1, 
p.2) 

o Open the recording in Praat’s Edit window  
 
IMPORTANT NOTES 
o Use the worksheet to note down all measurements, and to answer the questions asked 

throughout the lab.  
o Do not use decimals for any of your measurements (good: 90 Hz; bad: 90.75 Hz) 

 
 

SECTION I. FUNDAMENTAL FREQUENCY (F0) OR PITCH 
 
1. Measure the fundamental frequency (pitch) in the middle of each [æ] using the three 

techniques below and fill out Table 2.1.  
 
Q1: Which method do you prefer and why?  
 
 
Three ways to measure fundamental frequency: 
 
a. By displaying the pitch track and having Praat measure the pitch automatically (see Fig. 2.1): 
o Display the pitch track: Pitch > Show pitch 
o Place your cursor in the middle, stable portion of the vowel 
o Go to Pitch > Get pitch: a box will appear with the pitch value in it. 

 
 
TIP If the blue pitch contour (blue line) doesn’t appear clearly, it is because Praat’s default 

pitch range is not appropriate for the file you’re listening to:  
o go to Pitch > Pitch settings…   
o adjust the pitch range so you can see the pitch contour clearly:  

→ If you have a very high voice you may need to adjust the range upwards. 
→ If you have a very low voice you may need to adjust the range downwards. 
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b. By displaying the pitch track and measuring pitch manually (see Fig. 2.1): 
o Display the pitch track: Pitch > Show pitch 
o Click on the blue pitch track in the middle of the vowel 
o A red horizontal bar should appear, with the pitch value (in dark blue) on the right side of 

the window. 
 
 
TIP The Fundamental frequency value is always displayed on the right side of the window in 

dark blue; formant frequencies are displayed on the left side in red – be careful not to get 
these two confused! 

 

 

 

Display the pitch track: 
Pitch > Show pitch 

Pitch contour 

Adjust pitch range: 
Pitch > Pitch settings 

Use Get pitch to 
get a box with 
pitch value 

Pitch value 
as measured 
manually 
 

Place your cursor 
in the middle, 
stable portion of 
the vowel. 

 
Figure 2.1 Getting a pitch value in Praat 
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c. By looking at the waveform (top of the display) (see Fig. 2.2) 
o Zoom into a small piece of the waveform in the middle of the vowel and measure the 

period by highlighting one complete cycle and noting the time associated with it (in the 
panel above the waveform) 

o To get the frequency (f) from the period (T): f =1/T  
 
 
TIP If you zoom in enough, the panel above the waveform will include both the period and the 

frequency (in parentheses), so you don’t have to do any calculations. 
 
 

 

Zoom into a small 
piece of the 
waveform in the 
middle of the vowel 

highlighting one cycle 
in the waveform 

Period (T) of 
one cycle 

Frequency 
(f)= 1/T 

 
 
 

Figure 2.2 Calculating pitch by waveform 
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SECTION II. HARMONICS 
 
When our vocal folds vibrate, the result is a complex wave, consisting of the fundamental 
frequency (which you just measured) plus other higher frequencies, called HARMONICS. To see 
these, we need to look at a NARROW-BAND spectrogram, which is more precise along the 
frequency domain than the default WIDE-BAND spectrogram. 
 
2. Display a narrow-band spectrogram: 
 
o Go to: Spectrum > Spectrogram settings…  (see Fig. 2.3) 
o Change the window length to 0.025s (see Fig. 2.3) 

(The default is window length is 0.005s, which displays a wide-band spectrogram)  
 
→ This changes the spectrogram dramatically!  

 
 
Q2: What is the tradeoff that is apparent when comparing a wide-band to a narrow-band 

spectrogram? 
 

 

 

H1: the first 
harmonic 

H2 

H10 

Change window 
length to 0.025. 

A red horizontal bar 
should appear, with the 
frequency value on the 
left side of the window.  
 

Harmonics that 
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formants 

 
Figure 2.3 Harmonics 
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3. Looking at each [æ], notice the grey horizontal bands: these correspond to harmonics (see 
Fig. 2.3). For each [æ], measure the frequency of the first 3 harmonics (H1-H3), plus of the 
10th harmonic (H10). Use Table 2.2 to note down your measurements. 

 
o Click on the centre (horizontally) of each harmonic, in the centre (vertically) of each [æ] 
o A red horizontal bar should appear, with the frequency value on the left side of the window, 

in red.  
 
Q3: Compare the frequency of H1 with the fundamental frequencies measured in 1 above. Based 

on this comparison, what does the first harmonic (H1) correspond to? 
 
 
TIP If you have a very low voice, the first first dark line you see may be H2, instead of H1. 

Ask your instructor if you are not sure. 
 
Q4: What is the relationship between the first and subsequent harmonics? (the relationship 

should be the same across [æ]s) 
 
 
TIP Keep in mind there will be measurement error here, so various relationships may not be as 

clear as they would be in an ideal world…  
 
 

SECTION III. FORMANTS 
 
Looking at the narrow-band spectrogram, you should notice that some harmonics are darker than 
others (see Fig. 2.3). Darkness corresponds to loudness, i.e. the darkest harmonics are the ones 
that are the most amplified. These amplified harmonics form the FORMANTS that are 
characteristic of sonorant speech sounds. 
 
4. Now, go back to the wide-band spectrogram: 
o Go to: Spectrum > Spectrogram settings…  
o Change the window length back to 0.005 ms (the default) 

 
You will see that the formants appear on the wide-band spectrogram as thick dark bands.  
 
5. Measure the first and second formants (F1 and F2) in the middle of each [æ] using the three 

techniques outlined below and note down your measurements in Table 2.3. 
 
Q5: Which method do you prefer and why?  
 
Three ways to measure formants: 
 
a. By displaying the formants (red dots) and having Praat measure the frequency of each one 

automatically (see Fig. 2.4): 
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o Display the formant track: Formant > Show formants 
o Place your cursor in the middle, stable portion of the vowel 
o Go to Formant > Formant listing: a box will appear with the time point at which the 

measurement was taken, and the first four formants (F1 and F2 are the important ones now). 
 

b. By displaying the formants and measuring the frequency of each one manually: 
o Display the pitch track: Formant > Show formants 
o Place your cursor in the center of each formant, in the middle of the vowel 
o A red horizontal bar should appear, with the frequency value on the left side of the window, 

in red (see Fig. 2.4). 
 
c. By measuring the frequency without displaying Praat’s formants – this is sometimes easiest if 

Praat’s formant tracking goes wonky. 
o Get rid of Praat’s formant tracking: Formant > Show formants (unclick) 
o Place your cursor in the center of each formant, in the middle of the vowel 
o A red horizontal bar should appear, with the frequency value on the left side of the window, 

in red. 
 
Q6: Would you say the formant frequencies are the same or different across [æ]s?  

(Be sure to take measurement error into account when answering this question.) 

 

 

Formant display: 
First formant = F1 

Place your cursor in the 
center of a formant 

Display formants: 
Formant > Show formants 

Use Formant listing to 
get a box with the first 4 
formant frequencies 

F2 

Formant frequency 

 
Figure 2.4 Formants 
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SECTION IV. THE RELATIONSHIP BETWEEN HARMONICS AND FORMANTS 
 
The relationship between the harmonics and the formants is captured in the SOURCE-FILTER 
MODEL of speech production. In this last section of the lab, think about what the source and filter 
might be in this model.  
 
o Go back to the narrow-band spectrogram (refer back to Section II, p.15). 
o Get rid of the pitch contour: Pitch > Show pitch (unclick) 

 
6. What is the ordinal number of the harmonic (H2, H5, H8, etc.) that is at the centre of the first 

formant, for each [æ]? Use Table 2.4 to note down your answer. 
 
Q7: Does the harmonic you noted Table 2.4 have the same number across [æ]s?  
 
Q8: What explanation is there for the pattern observed in Tables 2.3 and 2.4: why would the 

harmonic number be different across [æ]s (Table 2.4), but the frequency of this harmonic 
(approximately = F1) be (approximately) the same across [æ]s (Table 2.3)?  

 
ð To answer this question, think about what creates harmonics vs. formants…  
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LAB 2 – THE SOURCE-FILTER MODEL OF SPEECH – WORKSHEET 
 

SECTION I. FUNDAMENTAL FREQUENCY (F0) OR PITCH 
 
Table 2.1 Fundamental frequency measurements 
Recording Pitch contour 

(automatic) 
Pitch contour 
(manual) 

Waveform  
(one cycle) 

[æ] low pitch  
 

  

[æ] mid pitch  
 

  

[æ] high pitch  
 

  

 
Q1: Which method do you prefer and why?  
 
 
 
 
 
 

SECTION II. HARMONICS 
 
Q2: What is the tradeoff that is apparent when comparing a wide-band to a narrow-band    

spectrogram? 
 
 
 
 
 
Table 2.2 Harmonics measurements 
 [æ] pitch H1 H2 H3 H10 
Low  

 
   

Mid  
 

   

High  
 

   

 
Q3: Compare the frequency of H1 with the fundamental frequencies measured in 1 above. Based 

on this comparison, what does the first harmonic (H1) correspond to? 
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Q4: What is the relationship between the first and subsequent harmonics? (the relationship 
should be the same across [æ]s) 

 
 
 

SECTION III. FORMANTS 
 
Table 2.3 Formants measurements 
Recording With formant 

tracking (automatic) 
With formant 
tracking (manual) 

Without formant 
tracking (manual) 

[æ] low pitch F1: 
 
F2: 

F1: 
 
F2: 

F1: 
 
F2: 

[æ] mid pitch F1: 
 
F2: 

F1: 
 
F2: 

F1: 
 
F2: 

[æ] high pitch F1: 
 
F2: 

F1: 
 
F2: 

F1: 
 
F2: 

 
Q5: Which method do you prefer and why?  
 
 
 
 
 
Q6: Would you say the formant frequencies are the same or different across [æ]s?  

(Be sure to take measurement error into account when answering this question.) 
 
 
 
 
 

SECTION IV. THE RELATIONSHIP BETWEEN HARMONICS AND FORMANTS 
 
Table 2.4  
Recording Number of the harmonic corresponding to first dark band in narrow-band 

spectrogram (e.g. H1, H4) 
[æ] low pitch  

[æ] mid pitch  

[æ] high pitch  
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Q7: What is the ordinal number of the harmonic (H2, H5, H8, etc.) that is at the centre of the first 
formant, for each [æ]? Does this harmonic have the same number across [æ]s? Use Table 
2.4 to note down your answer. 

 
 
 
 
 
Q8: What explanation is there for the pattern observed in Tables 2.3 and 2.4: why would the 

harmonic number be different across [æ]s (Table 2.4), but the frequency of this harmonic be 
(approximately) the same across [æ]s (Table 2.3)?  

 
ð To answer this question, think about what creates harmonics vs. formants…  
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LAB 3 – VOWEL PROPERTIES 
 
GOAL OF LAB 3 
In this lab, we are going to explore vowel properties: INTRINSIC PITCH and SPECTRAL MAKE-UP 
(FORMANT STRUCTURE). 
 
RECORDING  
 

o Record yourself saying the words beat, bit, bait, bet, bat, boat, but, boot (see LAB1, p.2) 
 
Take a quick look at your vowels in the Edit window, and make sure you can clearly see the 
vowel formants (see LAB1 on formant display, p.4). If you have trouble seeing them, you can 
download the file LAB3_ EnglishVowels.wav and take your measurements on this file. If you do 
this, please make a note of it on your worksheet. 
 

o Go to http://web.uvic.ca/ling/coursework/ling380/index.html 
o Follow the instructions on the webpage to download Lab3_EnglishVowels.wav onto the 

desktop. 
 
1. Which vowels are contained in these words? Fill in the appropriate IPA symbols on the top 

row in Tables 3.1, 3.2 and 3.3 and the bottom line of Figure 3.3 on the worksheet. 
 
Q1: In this lab, you should take all of your measurements in approximately the same spot: what 

spot is this and why? 
 
 

SECTION I. INTRINSIC PITCH 
 
2. Measure the pitch (F0) in each of the vowels (see LAB2, p.12). If your pitch values seem 

strange, try using another measurement method as confirmation (the waveform, using the 
pitch contour). Remember that measuring off the waveform is the safest, since it avoids 
counting on Praat’s automated pitch tracker. Note down your measurements in Table 3.1: 

 
3. You can also confirm your pitch measurement by looking at the spectral slice, which gives 

the component frequencies and their amplitudes (see Fig. 3.1). 
 

o Select a portion of the vowel (70-80ms) 
o Spectrum > View spectral slice 
o Click on the first (big) peak = H1 = F0 (Ignore any small spikes at the beginning, this 

might just be noise.) 
o Note down the frequency of this peak (at the top of the vertical bar) 

 
4. Use the confirmed pitch values from Table 3.1 and plot the pitch of each vowel on Figure 

3.3 on your answer sheet, Make sure you label your y-axis, using a scale that allows you to 
spread out your measurements as much as you can. 
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Q2: Is pitch the same across all vowels? Do you notice any patterns with it?       
 

 
Figure 3.1 Using a spectral slice to measure F0 

 

Select a portion of 
the vowel (0.077s = 
77 ms) 

Spectrum >  
View spectral slice 

 

The first big peak = F0 = H1 

The frequency of 
this peak = F0 
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SECTION II. SPECTRAL MAKE-UP (FORMANT VALUES) 
 

5. On the default wide-band spectrogram, measure the first and second formants (F1 and F2) of 
each vowel (see LAB2, p.16). Enter the obtained values in Table3.2, and use them for 
plotting your vowel space in Figure 3.4 on the worksheet 

 
 
TIP 1. You can use Praat’s automatic Formant tracking to help you if you want,  just 

remember to use your judgment: trust yourself more than you trust  Praat! 
2. It’s not always easy locating formants. Don’t get discouraged, just do the best you can! 

 
Q3: Look at the formants values associated with different vowels: 

a. Why do formants differ across vowels? 
b. What does F1 seem to correspond to, in terms of articulation? 
c. What about F2? 

 
Now go to a narrow-band spectrogram (see LAB2, p.15) 
 
6. Optional step, for extra practice with harmonics: Count up from H1 (the first dark band on 

the spectrogram, see LAB2 if you can’t remember how to do this, p.15) and note down in 
Table 3.3 which harmonic contributes most to F1 and F2 for each vowel (see Fig. 3.2a or see 
LAB2, p.18). You can use formant track if it helps you to identify F1 and F2. 

 
7. Also optional: Confirm your answer by looking at the spectral slice (see Fig. 3.2b): 
 

o Select approximately 70-80ms in the middle portion of each vowel 
o Spectrum > View spectral slice 
o Zoom in a bit on the spectral slice 

o Select the target portion of the spectral slice 
o On the Zoom panel: Sel 

o Locate the approximate frequency of F1 (or F2). You can do this in two ways: 
o By moving the cursor around until you find the right frequency value at the top of the 

window, or  
o By using the Select menu in the spectrum slice window 

o Go to Select > Move cursor to…  
o Input the value of F1 (or F2) measured in (5) above; The cursor will automatically 

move to the right location 
o Identify the harmonic that corresponds most closely to F1 (or F2). 
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Figure 3.2a. Determining the harmonics in a narrow-band spectrogram 
 

Figure 3.2b. Determining the harmonics by spectral slice 
 

 

F1=942 Hz 

H7 contributes most to F1 

 

Approximate value of F1: 942.24 

The biggest peak 
around F1= H7 

F0=H1 F2= H12 

F0, F1 and F2 
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SECTION III. SUMMARY SO FAR 
 
You should now be fairly comfortable with the different displays that are regularly used in 
acoustic analysis: THE WAVEFORM, THE SPECTROGRAM (wide- vs. narrow-band), and THE 
SPECTRAL SLICE, plus – OVERLAID ON THE SPECTROGRAM – pitch pulses, fundamental frequency, 
formant contours, and amplitude (for a more detailed discussion of amplitude, see LAB6, C. 
ACOUSTIC INTENSITY, p.53). 
 
To be sure you’ve understood these displays and how to use them, answer the following 
questions: 
 
Q4:  In each of the main displays – waveform, spectrogram, and spectral slice – what is 

displayed on the horizontal axis and on the vertical axis? 
 
Q5:  What display(s) would you use if you’re interested measuring acoustically the following 

phenomena: 
 

� Tonal contrasts in Chinese 
� Stress in English  
� Co-articulatory effects of consonants on adjacent vowels 
� The pronunciation of voiced vs. voiceless stops across languages (e.g. in French vs. English) 
� Phrase-final glottalisation (creakiness) 

 
To answer these questions, think about what the acoustic cues are of these phenomena – that will 
lead you to think about which display best shows these acoustic cues. 
 
Q6:  What other phenomena of speech can you think of that you could measure acoustically? 

Which display would you use to measure these? 
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LAB 3 – VOWEL PROPERTIES – WORKSHEET 
 

SECTION I. INTRINSIC PITCH 
 
Q1: In this lab, you should take all of your measurements in approximately the same spot: what 

spot is this and why? 
 
 
 
 
Table 3.1 Intrinsic vowel pitches (F0) 
Formant [    ] [    ] [    ] [    ] [    ] [    ] [    ] [    ] 

Waveform   
 

       

Pitch contour 
(manual) 
 

 
 

       

Spectral slice 
 
 

        

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure3.3 Intrinsic vowel pitches.  

Please label your y axis with appropriate frequency intervals 

 [   ]          [   ]          [   ]          [   ]          [   ]          [   ]          [   ]          [   ] 

Pitch 
(Hz) 
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Q2: Is pitch the same across all vowels? Do you notice any patterns with it? 
 
 
 

SECTION II. SPECTRAL MAKE-UP (FORMANT VALUES) 
 
Table 3.2 Vowel formants 
Formant [    ] [    ] [    ] [    ] [    ] [    ] [    ] [    ] 

F1 (Hz)  
 

       

F2 (Hz)  
 

       

 

 
Figure 3.4 Plotting your vowel space 
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Q3: Look at the formants values associated with different vowels: 
a. Why do formants differ across vowels? 
b. What does F1 seem to correspond to, in terms of articulation? 
c. What about F2? 

 
 
 
Table 3.3 Contributing harmonics to vowel formants 
Formant [    ] [    ] [    ] [    ] [    ] [    ] [    ] [    ] 

# of H 
contributing 
to F1 

 
 

       

# of H 
contributing 
to F2 

 
 

       

 
 

SECTION III. SUMMARY SO FAR 
 
Q4: In each of the main displays – waveform, spectrogram, and spectral slice – what is displayed 

on the horizontal axis and on the vertical axis? 
 
 
Q5: What display(s) would you use if you’re interested measuring acoustically the following 

phenomena: 
 

� Tonal contrasts in Chinese 
� Stress in English  
� Co-articulatory effects of consonants on adjacent vowels 
� The pronunciation of voiced vs. voiceless stops across languages (e.g. in French vs. English) 
� Phrase-final glottalisation (creakiness) 

 
To answer these questions, think about what the acoustic cues are of these phenomena – that will 
lead you to think about which display best shows these acoustic cues. 
 
 
 
 
 
 
Q6: What other phenomena of speech can you think of that you could measure acoustically? 

Which display would you use to measure these? 
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LAB 4 – SONORANTS 
 
GOAL OF LAB 4 
Sonorants are: 

o similar to vowels in that they have formants 
o different from vowels in that they are generally lower amplitude  (and behave as 

consonants phonologically) 
In this lab, we are going to explore the acoustic correlates of different sonorants: NASALS [m n N], 
GLIDES [w j] and LIQUIDS [¨ l].  
 
RECORDING 
For this lab, you will need to download the following files onto the Desktop: 
File name  Sounds included 
a_N_a.wav   ama, ana, aNa 
WiJu.wav  wi, ju 
Ri_iR.wav  ¨i, li, i¨, il 
 

o Go to http://web.uvic.ca/ling/coursework/ling380/index.html 
o Download the sound files: Right click > Save target as…  

 
 

SECTION I. NASALS 
 
In this section, you should focus on what is common between all three nasals. 
 

o Open the file a_N_a.wav. Follow the instructions below and to fill in Table 1 on the 
acoustic correlates of different nasals. You don’t have to complete both A and B. Choose 
one to proceed. 

 
A. Nasal formants 
 
If you can’t remember how to measure formants, refer back to LAB2 (p.16). 
 
1. In Table 4.1, note down F1, F2 and F3 for each nasal, as measured in the middle of the 

nasal . 
 
Q1: Look at your measurements of F1, F2 and F3:  are there any systematic patterns across 

nasals? (Relate your answer to Q2 and Q3 below) 
a. Is there one formant with a similar frequency for all places of articulation?  
b. Is there one formant that has a much higher amplitude than the others, across nasals? 

 
B. Spectral slice 
 
2. Create spectral slices for each nasal and for one example of [a] (see LAB3, p.22). 
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3. In Table 4.1, note down the overall shape of the spectrum of each nasal, as well as the shape 
of [a] (one example of [a] is enough).  

 
Q2: Compare the spectral slices of the nasals vs. [a] – do you see any overall differences between 

the nasals on the one hand and [a] on the other? (Relate this to your answer to Q1 and Q3) 
 

C. Waveform 
 
4. Nasals have very distinctive waveforms. To see this, zoom in on 10 or so cycles. 
5. For each nasal, note down in Table 4.1 the shape of one cycle (see Fig. 4.1). Also note down 

the shape of one cycle of one example of the vowel [a].  
 
Q3: Do you notice a systematic pattern across nasals, that is missing in [a]? What causes this 

pattern? (Relate this to Q1 and Q2 above) 

 
D. Antiformants 
 
Antiformants are the opposite of formants – they’re bands of frequencies that are actively 
damped rather than amplified (we’ll talk about this in class). They show up on the spectrogram 

 

The shape of 
one cycle 

Figure 4.1. Nasal waveform 
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as bands of white, i.e. bands of ‘silence’ at particular frequencies (see Fig. 4.2). They can be hard 
to see, so don’t worry if their measurement seems hard. For finding antiformants, you may find it 
easier to get rid of the formant tracking. 
 
6. Again in Table 4.1, note down the frequency of A1 (Antiformant 1), A2 and A3 for each 

nasal, as measured in the middle of the nasal. 
 
Q4: Are there any systematic patterns across nasals: is there one antiformant with a similar 

frequency for all places of articulation? 

 
E. Formant transitions (correlates of place of articulation) 
 
This section is optional. Focus on the difference between the three nasals in this part. The easiest 
way to see the formant transitions is by displaying the formant tracking:   
 
7. In Table 4.1, draw lines to indicate the shape of the F1, F2 and F3 contours throughout each 

V1NV2 sequence.  
 

 

Antiformants 

Figure 6.2. Antiformants 
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Q5: Do you notice any differences between the contours, i.e. between the transitions into and out 
of nasals with different places of articulation? We’ll re-visit this question in future labs…  

 
 

SECTION II. GLIDES 
 
8. Open the files Wi.wav and Ju.wav. Follow the instructions below and fill in Table 2 on the 

acoustic correlates of different glides. 
 
A. Formants 
 
9. In Table 4.2, note down the frequency of F1, F2 and F3 for each glide, as measured around 

the mid point of the glide. 
 
 
TIP The mid point of [w] should be at about: 3.19s and the midpoint of [j] should be at about 

2.85s. 
 
Q6: Look at the formant structure of the glides: which vowel does each glide resemble? 
 
 
B. Formant transitions  
 
10. In Table 4.2, draw lines to indicate the F1, F2 and F3 contours throughout each GV 

sequence.  
 

Q7: Are any differences between the contours, i.e. between the transitions out of the two glides? 
What do you think may cause these differences (in terms of articulation). 

 
 

SECTION III. LIQUIDS 
 
11. Open the file Ri_iR.wav. Follow the instructions below and fill in Table 4.3 on the acoustic 

correlates of different glides. 
 
A. Formants 
 
Use only the coda [¨] and [l] (the 3rd word [i¨] and the 4th word [il] in the sound file) for these 
measurements: formants are easier to see in coda position because they are more “stretched out”.  
 
12. In Table 4.3, note down the frequency of F1, F2 and F3 for each liquid, as measured around 

the mid point of the liquid  
 
 
TIP The mid point of [¨] should be at about: 4.39s and the midpoint of [l] should be at about 

5.78s. 
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Q8: Make note of the differences between each liquid – which formant is most different between 
the two? 

 
B. Formant transitions 
 
Again, use only the coda [¨] and [l] ([i¨] and [il]) for these measurements.  

 
13. In Table 4.3, draw lines to indicate the F1, F2 and F3 contours throughout each VL sequence.  
 
Q9: Do you notice any differences between the contours, i.e. between the transitions into the two 

liquids? What do you think causes these differences? 
 
C. Formant transition durations: Onsets vs. Codas 
 
Certain sounds are pronounced differently in onset vs. coda position, including liquids. In this 
last part of the lab, you will compare one acoustic correlate of liquids across syllabic positions: 
duration. 
 
14. Onset: Use [¨i] [li] for the measurement of onset liquids. Measure the duration from the 

beginning of the L-V transition (where the formants start to move) to the point at which the 
formants stabilize in the following vowel (see Fig.4.3). Note down your measurement in 
Table 4.3 

 
the beginning of 
the L-V transition 

The point at which the formants 
stabilize in the following vowel 

 
Figure 4.3. Formant transition in onset position 
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15. Coda: Use [i¨] [il] for the measurement of onset liquids. Measure the duration between the 
beginning of the V-L transition (where the formants start to move) to the point at which the 
formants stabilize in the following liquid (see Fig. 4.4). Note down your measurement in Table 
4.3. 

 
Q10: Compare the transition durations in onset vs. coda position (¨i vs. i¨ and li vs. il) : which are 

longer? 
 
Q11: Can you think of any other differences between /l ¨/ in onset vs. coda position? (think about 

their articulations… ) 
 
 
 

 

The beginning of 
the V-L transition 

the point at which the formants 
stabilize in the following liquid 

 
 

Figure 4.4. Formant transition in coda position 
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 LAB 4  – SONORANTS – WORKSHEET 
 

SECTION I.  NASALS 
 
Table 4.1 Acoustic correlates of nasals 

Correlates [m] [n] [N] 

A. Nasal Formants 

F1 

F2 

F3 

F1 

F2 

F3 

F1 

F2 

F3 

Nasal 
spectral 

slice 
 

   

 
B. Spectral 

slice 
comparison 

 Spectral 
slice for [a] 

 

 

 

Nasal 
waveform 

 
 
 
 

  

C. 
Waveform 
comparison 

Waveform 
for [a] 

 
 
 
 

D. Antiformants 

A1 

A2 

A3 

A1 

A2 

A3 

A1 

A2 

A3 

E. Formant transitions 

 
 
 
 

  

 
Q1: Look at your measurements of F1, F2 and F3:  are there any systematic patterns across 

nasals? (Relate your answer to Q2 and Q3 below) 
a. Is there one formant with a similar frequency for all places of articulation?  
b. Is there one formant that has a much higher amplitude than the others, across nasals? 
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Q2: Compare the spectral slices of the nasals vs. [a] – do you see any overall differences between 
the nasals on the one hand and [a] on the other? (Relate this to your answer to Q1 and Q3) 

 
 
 
 
 
Q3: Do you notice a systematic pattern across nasals, that is missing in [a]? What causes this 

pattern? (Relate this to Q1 and Q2 above) 
 
 
 
 
 
 
Q4: Are there any systematic patterns across nasals: is there one antiformant with a similar 

frequency for all places of articulation? 
 
 
 
 
 
 
Q5: Do you notice any differences between the contours, i.e. between the transitions into and out 

of nasals with different places of articulation? We’ll re-visit this question in future labs…  
 
 
 
 
 
 
 
 

SECTION II. GLIDES 
 

Table 4.2  Acoustic correlates of glides 
 [w] [j] 
Formants (GV) F1 

F2 

F3 

F1 

F2 

F3 

Formant transitions (GV)  
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Q6: Look at the formant structure of the glides: which vowel does each glide resemble? 
 
 
 
 
 
 
 
 
 
 
Q7: Are any differences between the contours, i.e. between the transitions out of the two glides? 

What do you think may cause these differences (in terms of articulation). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SECTION III. LIQUIDS 
 
Table 4.3 Acoustic correlates of liquids 
 ¨ l 
Formants (VL) F1 

F2 

F3 

F1 

F2 

F3 

Formant transitions (VL)  
 
 
 
 

 
 
 
 

Formant transition duration 
 
 
 

onset 
 
coda 

onset 
 
coda 
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Q8: Make note of the differences between each liquid – which formant is most different between 
the two? 

 
 
 
 

Q9: Do you notice any differences between the contours, i.e. between the transitions into the two 
liquids? What do you think causes these differences? 

 
 
 
 
Q10: Compare the transition durations in onset vs. coda position (¨i vs. i¨ and li vs. il) : which are 

longer? 
 
 
 
 
Q11: Can you think of any other differences between /l ¨/ in onset vs. coda position? (think about 

their articulations… ) 
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LAB 5 – OBSTRUENTS 
 
GOAL OF LAB 5 
In this lab, we are going to explore the acoustic correlates of different obstruents in terms of two 
parameters: VOICING and PLACE OF ARTICULATION. 
 
RECORDING 
Download the 5 files you’ll be using onto the Desktop: 
 
File name   Sounds included 
Lab5_a_stop_a.wav   (apha, aba, atha, ada, akha, aga) 
Lab5_a_stop.wav  (lap, lab, bat, bad, rack, rag) 
Lab5_i_stop_i.wav  (iphi ibi, ithi, idi ikhi, igi) 
Lab5_a_fricative_a.wav (afa, aTa, asa, aSa, aha) 
Lab5_shoe_chew.wav  (shoe, chew) 
 

o Go to http://web.uvic.ca/ling/coursework/ling380/index.html 
o Download the sound files. 

 
 

SECTION I. STOP CONSONANTS 
 
A. Voicing 
 
Three important acoustic correlates of VOICING in stops are: THE VOICE BAR, VOT, and THE 
DURATION OF THE PRECEDING VOWEL. For each of the stops in the file, take the three 
measurements according to the instructions below. Use Table 1 to fill in the measurements you 
take on voicing. Answer the related questions by comparing across all stops after you complete 
the table. 
 
1. Open the following sound file in Praat: a_stop_a.wav. Note down the presence vs. absence 

of the voice bar (see Fig. 5.1) during the stop closure of each consonants in Table 5.1 on the 
worksheet. 

 
Q1: If the voice bar is present at all, does it last through the duration of the closure? Why do you 

think it might go away?  
 
2. Still using the sound file a_stop_a.wav, measure the VOT of each stop and fill in Table 5.1. 

Compare voiced/voiceless counterparts (p/b, t/d, k/g): 
 

o Zoom in so that you can clearly see the stop closure followed by the beginning of the vowel. 
o Measure the time between the end of the stop closure ( = the beginning of the release burst) 

and the onset of voicing in the following vowel (= the onset of regular pitch pulses in the 
waveform). This is voice onset time, or VOT. 
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Voice bar Closure VOT 
 

 
Release burst Onset of 

voicing  
Aspiration 

VOT 

 
 

Figure 5.1 Voice bar and VOT measurement 
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Q2: How does VOT differ in voiced vs. voiceless stops and what articulatory explanation can 
you come up with for this? 

 
3. Now open a different sound file a_stop.wav in Praat. Measure the duration of the vowel 

preceding each stop, and fill in Table 5.1 on the worksheet. Compare vowel durations in the 
voiced vs. voiceless series. 

 
Q3: How does the duration of the preceding vowel differ depending on the voicing of the 

following consonant? 
 

B. Place of Articulation 
 
Several acoustic correlates distinguish between different PLACES OF ARTICULATION in stops. The 
main ones are VOT, spectral pattern during aspiration (voiceless stops), and transition into the 
adjacent vowels. We will focus on formant transitions in this section; THE SECTIONS ON 
MEASURING VOT AND SPECTRAL PATTERN ARE OPTIONAL. Focus on the differences associated 
with place of articulation (i.e. the differences between /p b/, /t d/ and /k g/. 
 

o Open the following sound files in Praat: a_stop_a.wav and i_stop_i.wav 
o Focus on the voiced stops for now 

 
4. In Table 5.2, note down the formant transition shape (particularly F2) between each voiced 

stop and the following [a] or [i] vowel (see Fig. 5.2). 
o Zoom in so that you can clearly see the formant transition from the stop into the following 

vowel. 
o Note down the movement contour of F2 (and F1 if you can see it) into the following vowel. 

Figure 5.2 Formant transition from the stop to the following vowel 
 

F2 formant transition 
from the stop to the 
folloing vowel 

F1 formant transition 
from the stop to the 
folloing vowel 
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Q4: How do the different places of articulation differ with respect to the F2 transitions into the 
following vowels? What causes these differences? 

 
Q5: Looking specifically at [ada] and [idi], do you notice a difference in the formant transitions? 

What do you think causes this difference? 
 
 
Optional Questions on VOT and Spectral Patterns 
 
5. VOT: In Table 5.3, note down the VOT for each of the voiceless stops in the [a] and [i] 

contexts (see Figure 5.1; note: you should already have the VOTs for the voiceless stops in 
the [a] context in Table 5.1 – you can measure them again to confirm your measurements if 
you want to). 

 
Q6: How does the VOT differ depending on POA, and why?  
 
Q7: Are there any overall differences in VOT between stops preceding [a] vs. [i]? If so, why 

might this be the case? 
 
6. Spectral Pattern: In Table 5.3, note down the overall spectral pattern during the aspiration 

of each voiceless stop in the [a] context: what frequencies seem most amplified, i.e. where is 
most of the aspiration noise? 
 

There are two ways to look at overal spectral pattern during the aspiration. Choose one of 
these to complete 6 above. 
 
a. By looking at the spectrogram 
 

o Zoom in on the spectrogram so you can clearly see the aspiration. 
o Observe the overall distribution of frequencies and amplitudes by looking at the 

spectrogram. 
 
b. By looking at the spectrum 

It might help here to also take a look at the spectrum during aspiration (see Fig. 5.3 for an 
example using a fricative, which is similar to aspiration): 

o Zoom in on the aspiration portion of the stop. 
o Select approximately 25ms during the aspiration portion of the stop. 
o Spectrum > View spectral slice. 
o Note down the overall shape of the spectrum – again, look at which frequency ranges are 

most amplified? 
 
 
Q8: How does the spectral pattern differ depending on POA, and why? 
 
(This question is tricky. Don’t worry too much if you can’t see a pattern here. We’ll talk about 
what you should see and why in class!) 
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SECTION II. FRICATIVES 
 
Different PLACES OF ARTICULATION in fricatives are correlated with two main properties: spectral 
content and relative amplitude. By examing the OVERALL SPECTRAL CONTOUR, PEAK FREQUENCY 
and the AMPLITUDE OF PEAK FREQUENCY, we can have an idea of the properties of a fricative.  
 
7. Use Table 5.4 to fill in the measurements you take on these three dimensions and compare 

between fricatives of different POA. 
 
For this portion of the lab, make sure that the spectrogram is set to display frequencies up to 
9000 Hz: 

o Spectrum > Spectrogram settings…  
o View range: up to 9,000Hz 

 
o Open the following sound file in Praat: a_fricative_a.wav 
o Select approximately 80ms in the middle of each fricative 
o Spectrum > View spectral slice 
o For each fricative, note down: 

o The overall shape of the spectral contour 
o The spectral peak: the frequency or frequencies around which most of the energy is 

centered, i.e. the highest amplitude frequencies (the highest peaks) 
o The amplitude of the peak frequency or frequencies (that you noted down above) – note: 

the positive dB values are louder than the negative dB values. 
 

Figure 5.3 Fricative spectral analysis 
 

Overall spectral contour 

Peak frequency value 

Amplitude of the peak frequency 
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TIP You can also get a good idea of the frequency ranges and their relative amplitudes by 
looking at the spectrogram. 

 
Q9: Among the fricatives you measured, which ones are highest/lowest in amplitude? What do 

you think is the reason for this (think about articulation)? 
 
Q10: Compare the spectral peaks of [s] vs. [S]. What do you think causes the difference between 

these two fricatives?  
 
 

SECTION III. AFFRICATES VS. FRICATIVES 
 
The main difference between affricates and fricatives is RISE TIME, i.e. the time it takes between 
the onset of the consonant and the point where the amplitude is stable and high. 
 
8. Use Table 5.5 to note down your measurements of rise time in [Su] ‘shoe’ vs. [tSu] ‘chew’: 

o Open the sound file in Praat: shoe_chew.wav 
o Zoom in so you can clearly see the whole of the fricative/affricate, including its onset. 
o On the waveform, measure the duration between the onset of the frication and the point 

where the amplitude reaches a stable high intensity  
 
Q11: Which has a longer rise-time, the fricative or the affricate? 
 

 
Figure 5.4 Measuring rise time in fricatives and affricates 

Rise time 

The amplitude 
reaches a stable high 
intensity. 
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LAB 5 – OBSTRUENTS – WORKSHEET 
 

SECTION I. STOPS 
 
Table 5.1. Acoustic correlates of VOICING in stops 

                              Stops 
Correlates   ph b th d kh g 

Is it there?  
 

     
1.  Voice bar 
(a_stop_a.wav) How long 

does it last? 
      

2. VOT (ms) 
(a_stop_a.wav) 

 
 
 
 

     

3. Preceding V duration (ms) 
(a_stop.wav) 

 
 
 
 

     

 
Q1: If the voice bar is present at all, does it last through the duration of the closure? Why do you 

think it might go away?  
 
 
 
 
 
 
Q2: How does VOT differ in voiced vs. voiceless stops and what explanation can you come up 

with for this? 
 
 
 
 
 
 
Q3: How does the duration of the preceding vowel differ depending on the voicing of the 

following consonant? 
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Table 5.2. Acoustic correlates of PLACE OF ARTICULATION in stops: formant transitions 
            Stops 

Correlate 
b d g 

[i] 
context 

 
 
 

  

4.Formant 
transitions 

 [a] 
context 

 
 
 

  

 
Q4: How do the different places of articulation differ with respect to the F2 transitions into the 

following vowels? What causes these differences? 
 
 
 
Q5: Looking specifically at [ada] and [idi], do you notice a difference in the formant transitions? 

What do you think causes this difference? 
 
 
 
 
Table 5.3. Acoustic correlates of PLACE OF ARTICULATION in stops: VOT and Spectral Pattern 

            Stops 
Correlates 

ph th kh 

[i] 
context 

 
 

  

5. VOT 
 [a] 

context 
 
 

  

6. Overall spectral 
pattern during 

aspiration 

 
 
 
 
 
 

  

 
Q6: How does the VOT differ depending on POA, and why?  
 
 
 
Q7: Are there any overall differences in VOT between stops preceding [a] vs. [i]? If so, why 

might this be the case? 
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Q8: How does the spectral pattern differ depending on POA, and why? 
(This question is tricky. Don’t worry too much if you can’t see a pattern here. We’ll talk 
about what you should see and why in class!) 

 
 
 
 
 

SECTION II. FRICATIVES 
 
Table 5.4 Acoustic correlates of PLACE OF ARTICULATION in fricatives. 

7. Overall spectral contour Peak frequency (Hz) Amplitude of 
peak frequency 

[f] 
 

 
 
 

  

[T]  
 
 

  

[s]  
 
 

  

[S]  
 
 

  

[h]  
 
 

  

 
 
Q9: Among the fricatives you measured, which ones are highest/lowest in amplitude? What do 

you think is the reason for this (think about articulation)? 
 
 
 
 
 
Q10: Compare the spectral peaks of [s] vs. [S]. What do you think causes the difference between 

these two fricatives?  
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SECTION III. AFFRICATES VS. FRICATIVES 
 
Table 5.5 Acoustic correlates of fricatives vs. affricates: rise time 

8. [S] 
 

[tS] 

Rise time (ms) 
 

  

 
 
Q11: Which has a longer rise-time, the fricative or the affricate? 
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LAB 6 – PHONATION TYPES 
 
GOAL OF LAB 6 
In this lab we are going to explore the three main phonation types used across languages: MODAL 
VOICING, CREAKY VOICING, AND BREATHY VOICING.  
 
RECORDING 
Go to http://web.uvic.ca/ling/coursework/ling380/index.html and download the 3 files: 
Lab6_Breathy Voice.wav 
Lab6_Modal Voice.wav 
Lab6_Creaky Voice.wav 
 

o Open the sound files in Praat 
o Fill in the cells of Table 6.1 on the worksheet to compare voicing types in terms of 

different parameters. Follow the instructions below for taking the appropriate 
measurements. 

 
 
TIP Since the word “voice” occurs in all three recordings, this is a good word to use for 

comparing across phonation types. Unless otherwise noted, measurements should be 
taken around the transition point between [o] and [i] in [oi] of voice, i.e. where the 
formants start spreading out. Here are approximate transition points in each file:  

o Modal voicing: 0.590s (see Fig. 6.1) 
o Creaky voicing: 0.703s  
o Breathy voicing: 0.654s  

 
TIP Always keep in mind that what matters in comparing measurements are relative values 

rather than absolute values. E.g. in measuring jitter, what matters is which phonation type 
has the most jitter, not what the exact measurement is. 

 
 

 

Time point = 0.590s 

Transition point 
between [o] and [i] 

 
Figure 6.1 Measurement point 
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A. Fundamental frequency (F0) 
 
1. Fundamental frequency can be a good indication of phonation type. Note down F0 at the 

measuring point of the three phonation types in Table 6.1 (if you can’t remember how to do 
this, see LAB2, p.12). 

 
B. Periodicity 
 
There are two things to consider here: 
a.  How regularly the pitch pulses occur =  degree of periodicity in the waveform 
b.  How many higher-frequency components there are in the waveform = spectral noise 
 
2. The degree of periodicity can be quantified by measuring the jitter: the variation in the 

duration of successive F0 cycles (see Fig. 6.2). Follow the instructions below and note down 
your jitter measurements. 

 
high jitter value = high degree of aperiodicity in the glottal source 

 
TIP You will not be able to get a jitter value unless the pitch pulses are showing up correctly 

in the waveform (the blue vertical lines on the waveform, see Fig. 6.2). If at the suggested 
point of measurement (see above), there are no pitch pulses, measure jitter at some other 
point where you do see the pitch pulses. 

 

 

 

Select a small portion of the 
waveform: 0.076s= 76ms 

Jitter value 

Make sure the pitch pulses 
are showing up correctly in 
the waveform 

 
Figure 6.2 Jitter measurement 
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o Measure Jitter value 
o Pulses > Show pulses 
o Select a small portion (70-80 ms) of the waveform around the measurement point OR 

where where you see pitch pulses clearly. 
o Pulses > Voice report 
o In the report window, get value for Jitter (local), and note this down in Table 6.1 

 
3. Also on the waveform you can see how much spectral noise there is in the signal by how 

complex the waveform looks (see Fig. 6.3). Note down your judgment on how much noise 
you observe. 

 
lots of little jagged peaks = lots of spectral noise in the higher frequencies 

 
o Zoom in on the waveform until you can clearly see a few cycles (Fig. 6.3) 

 
 

 
 
 
 

 

Examples of jagged peaks 

Figure 6.3 Jagged peaks 
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C. Acoustic intensity 
 
The three phonation types also differ in intensity. There are two ways to consider the intensity 
difference, introduced below. 
 
4. Acoustic intensity can be ‘eyeballed’ by viewing the waveform or spectrogram directly. 

Note down the relative darkness on spectrogram and the relative size of deviations from zero 
waveform for different phonation types in Table 6.1. 

 
relative darkness = loudness (spectrogram) 

relative size of deviations from zero waveform = loudness (waveform) 
 
5. Amplitude can also be quantified by viewing the amplitude envelope (yellow contour) on the 

spectrogram display (see Fig. 6.4). Note down the green amplitude value (in dB) on the right 
of the screen for different phonation types. 

 
o Intensity > Show intensity 
o Find the peak intensity (highest point on yellow amplitude contour) during the vowel [oi] 
o Click on the amplitude contour at this point. 
o Note the green amplitude value (in dB) on the right of the screen 

 
 

 

 

Zero waveform 

Derivation from zero waveform 

Amplitude envelop Peak intensity during 
the vowel [oi] 

 
 

Figure 6.4 Acoustic intensity 

Amplitude 
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D. Spectral tilt 
 
Spectral tilt is the degree to which intensity drops off as frequency increases 
 
6. Spectral tilt can be eyeballed by looking at a spectral slice of the waveform, which gives the 

component frequencies and their amplitudes (see Fig. 6.5 a). Note down the overall slope of 
the spectrum for different phonation types in Table 6.1. 

 
o Select a portion (70-80 ms) of the waveform around the measurement point (given above).  
o Spectrum > View spectral slice  
o The overall slope of the spectrum (= how quickly the amplitude drops off in the higher 

frequencies) is an indication of spectral tilt: 
 

Steep slope = highly negative spectral tilt = rapid drop off in A of higher frequencies 
 

 
 
 

 
 

Figure 6.5a  Measuring spectral tilt – zoomed-out view 
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7. Spectral tilt can be quantified by comparing the amplitude of F0 to that of higher frequency 
harmonics, e.g. the second harmonic, the harmonic closest to the first formant, or the 
harmonic closest to the second formant. The easiest way to measure spectral tilt is by 
subtracting the amplitude of F0 (H1) from the amplitude of the second harmonic (H2) (see 
Fig. 6.5b). Fill in Table 6.1 with the spectral tilt value of the three phonation types. 

 
o Select the first few peaks (around 10 peaks) and zoom in so that you can see H1 and H2 

clearly 
o In the spectral slice, click on the peak of H1 and get its amplitude 
o (The number on the left of the screen corresponds to the amplitude; the number at the top 

of the screen corresponds to the frequency) 
o Click on the peak of H2 and get its amplitude 
o Calculate spectral tilt by this formula: Spectral tilt = A(H2)-A(H1) 

 
 
TIP H1 is the first big-sized peak; H2 is the second one. There may often be one or two lower 

amplitude peaks before H1, so make sure you’re measuring the right peaks. If you click 
on the first big peak (H1), the value at the top of the vertical red bar gives you its 
frequency. Make sure this frequency corresponds to F0 (as verified by some other 
measurement technique – see LAB2, p.12). Also make sure that the frequency of H2 is 
approximately twice the frequency of H1 (again, see LAB2 for the reasoning here, p.16). 

 

 

H1 (F0) 

H2 

Frequency of H1 

A (H1) 

 
Figure 6.5b Measuring spectral tilt – zoomed-in view 



LAB 6 – PHONATION TYPES 

56 

E. Formant frequency 
 
8. Non-modal phonation can affect the formant frequencies, particularly the first formant (F1). 

Note down F1 for each phonation type. 
 

o For this measurement, consider the stable (middle) part of the [o] portion of the [oi] 
diphthong, not the transition point between [o] and [i]. 

o On the spectrogram, click in the centre (vertical) of the first formant (F1) 
o The number at the left of the screen, at the end of the red horizontal bar gives you the 

frequency (in Hz) 
 
 
TIP You can use the formant tracings if they help: Formant > Show formants 
 
F. Duration of [oi] 
 
9. Duration can also be a good indication of phonation type (see Fig. 6.6). Note down the 

duration of [oi] for each phonation type. 
 

o Measure the duration for the whole diphthong [oi] by selecting the vowel 
o You can read the duration from the panel above the selected segment 

 
 
TIP To isolate [oi], you can use visual information (look for the change in the shape of the 

spectrogram/waveform). You can also use your ears. 

 

 

Select the diphthong [oi] 

Duration of the selection 

 
Figure 6.6 Duration measurement 
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G. Overall clarity of the spectrogram 
 
10. Finally, phonation types differ in the overall clarity of the spectrogram – this has to do with 

the amount of noise in the signal, etc. Note down your impressions of overall clarity of the 
spectrogram of each phonation type. 

 
Q1: Based on the measurements above: what is it about the articulation of these different 

phonation types that leads to the observed differences in your measurements? You can 
make any notes you’d like on the back side of the worksheet – we’ll discuss this question in 
class. 
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LAB 6 – PHONATION TYPES – WORKSHEET 
 
Table 6.1. Comparing acoustic correlates of different phonation types (enter values where 
measurements were taken; otherwise enter general comments) 
 
 Modal voicing Creaky voicing Breathy voicing 
 
1. Fundamental 

frequency 

   

2. jitter value 
 
 

    
 
Periodicity 
 3. spectral 

noise 
 

   

4. relative 
darkness on 
spectrogram / 
relative 
deviation on 
waveform 

    
 
 
Intensity 

5. amplitude 
value (dB) 

 
 
 

  

6. overall 
slope of the 
spectrum 

    
Spectral 
tilt  

7. A(H2) – 
A(H1) 

 
 
 

  

 
 
8. Formant frequency (F1 
value) 
 

   

 
9. Duration of [oi] (ms) 
 
 

   

 
10. Overall clarity of 
spectrogram 
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Q1: Based on the measurements above: what is it about the articulation of these different 
phonation types that leads to the observed differences in your measurements? You can 
make any notes you’d like on the back side of the worksheet – we’ll discuss this question in 
class. 
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LAB 7 – SUPRASEGMENTALS 
 
GOAL OF LAB 7 
In this lab we’re going to explore three different ways to use pitch (and other suprasegmental 
cues) within words: STRESS in Korean, PITCH-ACCENT in Japanese, and TONE in Mandarin. 
 
RECORDING 
For this lab, you will need to download the following files onto the Desktop: 
File name     Sounds included 
Korean_Stress.wav                         (zadáli, zánzu, zá:nzu) 
Japanese_PitchAccent.wav                 (hási, hasí, hasi, hási o nu}u, hasí o nu}u, hasi o nu}u) 
Mandarin_Tone.wav                          (ma55, ma35, ma214, ma51) 
 

o Go to http://web.uvic.ca/ling/coursework/ling380/index.html 
o Download the sound files onto the desktop 

 
 

SECTION I. KOREAN STRESS 
 
The most familiar way to use pitch, at least for English speakers, is to signal what we call STRESS 
(c.f. refuse used as a noun vs. as a verb). Stressed syllables are usually signaled by some 
combination of raised pitch, raised amplitude, and longer duration. Like English, Korean has 
stress. Unlike English though, Korean also has contrastive vowel length, which leads to some 
interesting uses of duration – as we’ll see! 
 

o Open Korean_Stress.wav, which contains the following words (  @ indicates stress; periods 
indicate syllable boundaries): 

 
za.dá.li  ‘ladder’ 
zán.zu  ‘landscape’ 
zá:n.zu  ‘arithmetic’ 
 
1. Use Table 7.1 to note down the measurements of the duration, pitch, and amplitude of the 

relevant segments in each word. 
 

o Display the pitch and amplitude contours 
o For duration:  

o For zadáli, measure the duration of each vowel. 
o For zánzu and zá:nzu, measure the duration of the vowel and the coda consonant [n] (in 

‘landscape’ and ‘arithmetic’) separately, and then measure the whole rhyme ([an] in 
‘landscape’ and [a:n] in ‘arithmetic’) 

o For pitch: measure the peak pitch in each syllable. Ignore any spikes right at the transitions 
between consonants and vowels. 

o For amplitude: measure the peak amplitude in each syllable. 
 
 
TIP In order to get a clear pitch contour in Praat, you may have to play with the pitch 

settings.(Compare Figure 7.1a with Figure 7.1b.) 
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Figure 7.1a Pitch range setting in Praat: 75-500Hz 

Pitch range set to 75.0-500.0 Hz: Maximum is set too high; as a result the contour is squished right at the 
bottom of the display and is difficult to read. 

 
Figure 7.1b Pitch range setting in Praat: 75-200Hz 

Pitch range set to 75.0-200.0 Hz: Maximum is more set more appropriately; as a result the contour is spread over 
the whole display and is easy to read. 

o Go to: Pitch > Pitch settings…  
o Play with the Pitch range (the default pitch range is 75.0-500.0 Hz): you should be able to 

set the min. and max. pitches to match (approximately) the pitches in your sound file. 

à This should give you a much clearer pitch contour. If even with changing the pitch range you 
can’t get a clear contour, you can always measure the pitch off the waveform, as you did in LAB2. 
 

Q1: Based on your measurements of the Korean sound file, answer the following questions: 
a. Which cues (duration, pitch, amplitude) does Korean use to signal stress?  
b. Take a look at the duration of [n] in ‘landscape’ vs. ‘arithmetic’. Why are these two [n]s 
so different in duration? 
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SECTION II. JAPANESE PITCH-ACCENT 
 
Pitch-accent is another way to mark prominence. Unlike stress, pitch-accent uses primarily pitch 
(as opposed to a combination of cues) to signal the prominent syllable. Japanese is an example of 
a pitch-accent language (Note: languages can have either stress or pitch-accent, but not both; 
they can also have neither).  
 

o Open the file Japanese_PitchAccent.wav, which contains the files below (  @ indicates 
accent): 

 
hási ‘chopsticks’  hási o nu}u ‘paint a bridge’ 
hasí ‘bridge’  hasí o nu}u ‘paint chopsticks’ 
hasi ‘end’   hasi o nu}u ‘paint the end’ 
 
2. Use Table 7.2 to note down the pitch contours and important pitch values associated with 

each word/phrase (the first word is done for you as an example). 
 

o For the words in isolation (first 3): measure pitch in the middle of each vowel 
o For the words in a phrase (last 3): measure pitch in the middle of first vowel, second vowel, 

and a point in the following chunk of signal where the pitch has stabilized (see Fig. 7.2). 

Q2: Based on your observations, how does pitch accent work in Japanese, i.e. how does the 
accented syllable affect the pitch of whole the word/phrase? 

 

 

Middle point 
of first vowel 

Middle point of 
second vowel 

A point in the following chunk 
where the pitch has stabilized   

Figure 7.2 Pitch measurement in Japanese 
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SECTION III. MANDARIN TONE 
 
Mandarin illustrates the most complex way of using pitch. Whereas stress and pitch accent both 
basically involve a binary distinction in pitch (stressed vs. unstressed; accented vs. unaccented), 
tone involves more than a binary distinction. In the case of Mandarin, four different pitches, or 
TONES, are used to signal phonemic contrast.  
 

o Open the file Mandarin_Tone.wav, which contains the four words that all have [ma] as 
their segmental content, but that each have a different tone: 

 
55 high level  ma55  ‘mother’ 
35 high rising  ma35  ‘hemp’ 
214 low falling  ma214  ‘horse’ 
51 high falling  ma51  ‘scold’ 
 
3. Use Table 3 to note down the frequencies used in each of the four tonal patterns. Measure 

the frequency at the start and end of the vowel, and at any turning points in the pitch contour. 
 
 
TIP For the most part you can use Praat’s pitch tracking function. There are some places 

where the tracking function cuts out though (see Fig. 7.3). To measure in such places, use 
the waveform. (If you can’t remember how to do this, refer to LAB2, p.14) 

 

 

Pitch tracking function cuts out here. Use the waveform to measure 
pitch or try lowering the min. pitch (pitch settings) to get a 
continuous contour.  

 
Figure 7.3 Tone measurement in Mandarin 
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Q3: From what you can tell, is there a consistent frequency associated with each phonological 
pitch number? How is phonological tone related to phonetic pitch? 

 
 

SECTION IV. TONE AND FOREIGN LANGUAGE ACQUISITION 
 
4. Now record yourself trying to reproduce each of the Mandarin tones. Take the same 

measurements on your own speech as you took for the Mandarin speech, and enter the 
values in Table 7.4 

 
Q4: How does your speech differ from the original Mandarin speech, in terms of: 

� Overall pitch range used (absolute pitch): your minimum and maximum pitch vs. the 
minimum and maximum speech of the Mandarin recording. 

� Relative pitch used, particularly in the contour tones: 35, 214, 51: what range of pitches 
do you use (min vs. max), compared to the original recording? 

 
Q5: Do you tend to overdo (exaggerate) the tones, or underdo them? 
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LAB 7 – SUPRASEGMENTALS – WORKSHEET 
 

SECTION I. KOREAN STRESS 
 
Table 7.1 Description of stress in Korean. 
 Duration (ms) Pitch peak (Hz) Amplitude peak (dB) 
za.dá.li a 

 
 

á i za dá li za dá li 

zán.zu á 

n 

an 

 
 
u 

 
 
zán 

 
 
zu 

 
 
zán 

 
 
zu 

zá:n.zu á: 

n 

a:n 

 
 
u 

 
 
zá:n 

 
 
zu 

 
 
zá:n 

 
 
zu 

 
Q1: Based on your measurements of Korean sound files, answer the following questions: 

a: Which cues (duration, pitch, amplitude) does Korean use to signal stress? 
 
 
 
 
 
 
 
 
b: Take a look at the duration of [n] in ‘landscape’ vs. ‘arithmetic’. Why are these two [n]s  

so different in duration? 
 
 
 
 
 



LAB 7 – SUPRASEGMENTALS 

66 

SECTION II. JAPANESE PITCH-ACCENT 
 
Table 7.2 Description of pitch-accent in Japanese. 
 Pitch contour and key frequencies (Hz) 
hási  

___145___  
    
                       ____85____ 
 
       [a]                    [i] 

hasí  
 
 
 
 

hasi  
 
 
 
 

 
Table 7.2 Description of pitch-accent in Japanese - Continued. 
 Pitch contour and key frequencies (Hz) 
hási o nu}u  

 
 
 
 

hasí o nu}u  
 
 
 
 

hasi o nu}u  
 
 
 
 

 
Q2: Based on your observations, how does pitch accent work in Japanese, i.e. how does the 

accented syllable affect the pitch of whole the word/phrase? 
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SECTION III. MANDARIN TONE 
 
Table 7.3 Description of the pitch contours used in Mandarin. 
Word F (start of 

vowel) 
F (turning 

point) 
F (end of 
vowel) 

Stylized pitch contour (within the 
vowel) - draw it 

ma55     

ma35     

ma214     

ma51     

 
Q3: From what you can tell, is there a consistent frequency associated with each phonological 

pitch number in Mandarin? How is phonological tone related to phonetic pitch? 
 
 
 
 
 
 
 
Table 7.4 Description of the pitch contours used in imitating Mandarin. 
Word F (start of 

vowel) 
F (turning 

point) 
F (end of 
vowel) 

Stylized pitch contour (within the 
vowel) - draw it 

ma55     

ma35     

ma214     

ma51     

 
Q4: How does your speech differ from the original Mandarin speech, in terms of: 

� Overall pitch range used (absolute pitch): your minimum and maximum pitch vs. the 
minimum and maximum speech of the Mandarin recording. 

� Relative pitch used, particularly in the contour tones: 35, 214, 51: what range of pitches 
do you use (min vs. max), compared to the original recording? 

 
 
 
 

Q5: Do you tend to overdo (exaggerate) the tones, or underdo them? 
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LAB 8 – DIALECTS OF ENGLISH 
 
GOAL OF LAB 8 
Many people can recognize different dialects of English when they hear them, but why? What 
makes dialects of English sound so different from one another? Your goal in this lab is to try to 
figure out what kinds of acoustic properties distinguish between different dialects of English. 
 
RECORDING 
For this lab, you will need to download the following files onto the Desktop: 
 
BritishRP.wav 
CanadianBC.wav   
Singapore.wav 
Tyneside.wav  
 

o Go to http://web.uvic.ca/ling/coursework/ling380/index.html 
o Download the sound files onto the Desktop 

 
1. Listen carefully to each of these files on its own to get a general idea of what words / sounds 

/acoustic properties you want to focus on for your analysis. You will have to exam at least 4 
parameters.  Use Table 8.1 on the worksheet as a guide/summary for your investigation. 

 
a.  For each dialect, note down you impression of what makes this dialect unique: what 

distinguishes it from the other dialects. 
 
b. Focusing on the words/sounds/acoustic properties you came up with as being unique for each 

dialect (see a. above), take the appropriate acoustic measurements, and compare them to 
similar measurements in other dialects. Note down your observations (see example tables on 
the worksheet). 

 
Q1: What articulations are responsible for making these words/sounds/acoustic properties 

different from those in other dialects? Can you imitate different these 
words/sounds/acoustic properties based on what you know about the relationship between 
acoustics and articulation? If you’re feeling really ambition, record your attempts and see 
how close you get! 

 
 
TIP 1. To compare dialects, it’s often useful to focus on specific words or phrases (e.g. 

‘disputing’ or ‘last’ ; ‘should be considered stronger than the other’ – see example tables 
on the worksheet).  
2. A few examples of the segmental and suprasegmental differences that you can focus on 
are provided on the next page and related example tables are included in the worksheet. 
You are encouraged to look at other aspects that interest you. 
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SECTION I. SEGMENTAL DIFFERENCES 
 
A. Consonants:  
 

� Pronunciation of intervocalic stop consonants (see Figure 8.1 and Example Table 8.2) 
� Pronunciation of coda consonants (see Table 8.3, refer to LAB5, p.42) 
� Presence vs. absence of coda /r/ (refer to LAB4, p.33) 
� Whether or not the stop consonants are released (aspirated) in coda position 

 
B. Vowels:  
 

� F1 and F2 measurements of a same vowel in different dialects (see Example Table 8.4). 
 
C. Overall amount of glottalisation 
 

� Remember glottalisation is usually accompanied by spreading out of the pitch pulses   
(see Figure 8.1 and Example Table 8.5, and refer back to LAB6, p.51 ) 

 

Pitch pulses spreading out on the spectrogram 

 
Figure 8.1 Glottalisation accompanied by spreading out of the pitch pulses 
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SECTION II. SUPRASEGMENTAL DIFFERENCES 
A. Intonation:  
 

� Compare general intonation contours of individual sentences: which dialect(s) have 
relatively flat vs. more sing-song-y contours; which words are the pitch maxima and 
minima aligned to? (see Example Table 8.6) 

 
B. Rhythm  
 

� E.g. compare Singapore English – which is supposed to be syllable-timed – to British 
English, by doing a quick %V calculation – as discussed in class (see Example Table 
8.7): 

o Segment a sentence of the sound file into CV sequences (see Figure 2. and refer back to 
LAB1 if you can’t remember how to create a textgrid, p.6) 

o Measure the duration of each vowel interval (V) in the sentence 
o Add up the total duration of vowel intervals, and get the total sentence duration. 
o %V = total duration of vowel intervals/sentence duration 

 

 

 

Segment a stretch of 
sound into CV sequences 
on a Textrgrid tier. 

When there are 2 or more consecutive consonants 
or vowels, they should be considered as a single 
C or V in segmentation. The highlighted portion 
of the sound includes 2 consonants but they are 
segmented into a single C interval.  

 
Figure 8.2 Segmenting a sound file into CV sequence 
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LAB 8 – DIALECTS OF ENGLISH - WORKSHEET 
 
Table 8.1 Differences in Dialects of English 
 
Dialects Unique quality of the 

dialect 
 

Acoustic correlate(s) 
of the unique 
quality(ies) 

Q1: Articulation 
explanation (optional 
during lab time) 

Canadian (BC)  
 
 
 
 
 
 

  

British RP  
 
 
 
 
 
 

  

Singapore  
 
 
 
 
 
 

  

Tyneside  
 
 
 
 
 
 

  

 
 
Q1: What articulations are responsible for making these words/sounds/acoustic properties 

different from those in other dialects? Can you imitate different these 
words/sounds/acoustic properties based on what you know about the relationship between 
acoustics and articulation? If you’re feeling really ambition, record your attempts and see 
how close you get! 
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Example measurements 
Here are some example measurements you can take in specific illustrative words. Note: you 
don’t have to take these measurements; you may find others you think are more relevant. Use 
your judgment to decide what to focus on. 
 

SECTION I. SEGMENTAL DIFFERENCES 
 
Table 8.2. Pronunciation of /t/ in ‘disputing’ 
 Glottalisation? Aspiration? IPA symbol 
Canadian (BC) no 

 
no R 

British RP  
 

  

Singapore  
 

  

Tyneside  
 

  

 
 
Table 8.3. Final nasal in ‘disputing’ 
 F2 movement* IPA symbol 
Canadian (BC) yes 

 
N 

British RP  
 

 

Singapore  
 

 

Tyneside  
 

 

* Movement upwards = into velar pinch = velar [N] 
 
 
Table 8.4. Vowel quality in ‘last’ (you can make similar tables for other vowels)* 
 F1 (Hz) F2 (Hz) duration (ms) IPA symbol 
British RP 769 

 
1285 163 [A] 

Singapore  
 

   

Tyneside  
 

   

* Note: Canadian (BC) English is missing from this table and the next one because the relevant 
sentence is missing from the recording. 
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Table 8.5. Glottalisation of consonants in ‘and at (last)’ 
 Transcription of /ændætl/ (‘and at l… ’ in ‘and at last’) 
British RP [ænd«tl ¥l]     ð no glottalisation 

 
Singapore  

 
Tyneside  

 
 
 

SECTION II. SUPRASEGMENTAL DIFFERENCES 
 
Table 8.6. Intonation pattern of ‘should be considered stronger than the other’ 
 Intonation pattern  

(qualitative observation) 
Pitch range used (Hz) 

Canadian 
BC 

 
 
 

max: 246 (241) 

min: 132 

range: 114 

‘considered’ (‘stronger’) 

‘other’ 

British 
RP 

 
 
 

max:  

min:  

range: 

 

Singapore   
 
 

max:  

min:  

range:  

 

Tyneside  
 
 

max:  

min:  

range:  

 

 
 
Table 8.7.  Rhythm: %V of ‘should be considered stronger than the other’ 
 Sum of V Duration (ms) Total Duration (ms) % of V 
British 
RP 

 
 
 

  

Singapore   
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LAB 9 – EXOTIC SPEECH SOUNDS 
 
GOAL OF LAB 9 
In this lab you will get a chance to take a look at some of the more ‘exotic’ speech sounds, i.e. 
sounds that are not found in English and that we have not yet discussed in class. Your task is to 
find a sound or set of sounds to explore, and provide a phonetic description of it/them. This lab 
work will be in preparation for the optional class presentations, and also in preparation for your 
last lab assignment of the term, in which you will be asked to select a set of sounds of your 
choice (from a language of your choice) and describe them. 
 
RECORDING 
For this lab, take a look at the following website: 
http://hctv.humnet.ucla.edu/departments/linguistics/VowelsandConsonants/ 
 
From this site you can click on: 

� Index of languages, or 
� Index of sounds 

From these indices you can find lots and lots of sounds to look at.  
o Download the sounds that interest you. 

o Right-click on the sound 
o Save target as…  

 
WARNING: in some cases the recording quality isn’t very good, making it difficult to analyse the 
sounds. Make sure you pick sounds that are clear enough (auditorily and visually) to analyze. 
 
 
TIP Here are some suggestions in terms of things to look at: 

o Take a sound/set of sounds that exists in English (that you’ve worked with) and compare it 
to a sound/set of sounds from another language written with the same IPA symbol(s). This 
will give you an idea of language-specific phonetics, and the kind of variation that exists 
across languages, for example: 
� VOT in the stop series 
� Vowel formants 
� /l/ across languages (dark vs. light) 

 
o Take a sound/set of sounds that doesn’t exist in English and explore the phonetic properties: 

� Duration differences in geminates vs. singletons/long vs. short vowels 
� Acoustic properties of clicks  
� Acoustic properties of implosives  
� Acoustic properties of ejectives 
� Acoustic properties of labialized sounds 

 
 
TIP Your last lab assignment involves choosing set of sounds and describing it phonetically. 

This is a good opportunity to start working on finding a set of sounds to work on and start 
doing some preliminary work towards the assignment! 
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LAB 9 – EXOTIC SPEECH SOUNDS – WORKSHEET  
 

Sound/sound set chosen: 
 
Language and language family: 
 
Reason for choosing this sound/sound set: 
 
 
Acoustic properties: 
 
Please create your own tables and/or diagrams below for illustrating the important acoustic 
properties of the sound(s) you’ve chosen. You can use previous worksheets as examples to figure 
out how to note down your measurements. 
 
 
 
Q1. What articulations do you think are at the source of the acoustic properties you measured in 

this lab? 
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LAB 10 – SPEECH SYNTHESIS 
 
GOAL OF LAB 10 
The goal of this lab is to try your hand at some speech synthesis. The possibilities for 
manipulating speech are virtually unlimited. In this lab we will play with VOICING and TONE. 
You will also get to create your own RAP SONG! 
 
RECORDING 
For this lab, you will need to download the following files onto the Desktop: 
 
File name   Sounds included 
Lab10_pa_ba.wav  (pa, ba) 
Lab10_lap_lab.wav  (lap, lab) 
Lab10_T1_T4.wav  (ma in T1, ma in T4) 
Lab 10_rap_example.wav (example of synthetically created “rap”) 
 

o Go to http://web.uvic.ca/ling/coursework/ling380/index.html 
o Download the sound files onto the desktop: 

 
 

SECTION I. VOICING MANIPULATION 
 
In the first section of the lab, we will learn to change a voiceless stop [p] into a voiced one [b]. 
 
A. VOT manipulation 
 
As we discovered in LAB5, VOT is an important acoustic cue for voicing in stops. Changing the 
VOT of a stop may change the identity of a stop. In this section you will manipulate the VOT of 
the stop in [pa] to get the stop in [ba]. 
 
1. Measure the VOT of [pa] vs. [ba] in natural speech and  note down your measurements in 

Table 10.1 (if you can’t remember how to do this, refer to LAB5, p.40).  
 
2. Follow the instructions below to create a [pa]~[ba] continuum by gradually cutting out 

aspiration in [pa]. Also note down the VOT of each token along your [pa]~[ba] continuum in 
Table 10.1. 

 
o Open sound file LAB10_pa_ba.wav in the Edit window.  
o Zoom in on [pa]: leaving the burst as is, cut out the aspiration in 10-20 ms steps, until 

there's no more aspiration at all (Fig. 10.1): 
o Go to Edit > Cut 

o Each time you cut out 10-20ms of aspiration, extract the token as a new sound file: 
o Highlight [pa] 
o File > Extract sound selection (preserve times) 

o In order to keep track of the tokens you are creating, rename the extracted selection: 
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o In the Praat objects panel: Rename 
o Sound untitled > Pa1 (after first cut), Pa2 (after second cut), P3…  

o You'll end up with about four tokens along a [pa]~[ba] continuum. 

Q1: Compare the synthesized [Pa]s4 you created with the natural [ba]:  
a. Which token sounds the closest to the original [ba], and how close does it sound?  
b. What other manipulations do you think would help to make it more natural? (and how 

would you do these manipulations?) 
 

B. Vowel length manipulation (optional) 
 
Another important acoustic cue to voicing in stops in coda position is the length of the preceding 
vowel. In this part, you will manipulate the length of the vowel in [lap] to make [lap] sound like 
[lab]. This part of the lab is optional. 
 
3. Open sound file Lab10_laplab.wav in the Edit window. Measure the length of the vowel in 

[lap] vs. [lab] in natural speech and note down your measurements in Table 10.2  
                                                 
4 “P” is used as the abstract version of [p ~b] that isn’t specified for voicing. This is common practice in 
phonological analysis as well. 

 

Leave the burst as is 

Cut out 10-20ms of 
aspiration at a time 
until the end of 
aspiration. 

 
 

Figure 10.1 VOT manipulation 
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There are two ways to manipulate vowel length: an easy/not so good way and a more 
difficult/better way. You can choose either way or try both. 
 
4. Use the easy/not so good way to lengthen a vowel: 
 

o In the Edit window, select a steady portion of the vowel in [lap] (20ms or so) 
o Copy and paste it after itself as many times as is necessary to reach the duration of the [a] 

in the natural [lab] 
o Edit > Copy selection to sound clipboard 
o Set cursor on the endpoint of the vowel section you selected 
o Edit > Paste after selection 

o When you’re done copying and pasting, extract the token as a new sound file: 
o Highlight [lap] 
o File > Extract sound selection (preserve times) 
o In the Praat objects panel: Rename 
o Sound untitled > laP1 

 
5. Measure the duration of the new vowel duration in [laP1] and note down the values in Table 

10. 2. 
 
Q2: Compare the synthesized [laP1] you created with the natural [lab].  

a. How close do they sound?  
b. What further manipulation(s) would make the synthesized and natural tokens more 

similar? 
c. What problems do you find with this way of manipulation? 

 
6. Now try the more difficult/better way to lengthen a vowel: 
 

o Re-open sound file LAB10_laplab.wav (from the desktop) 
 
 
TIP  You have to re-open the file because the LAB10_laplab.wav you opened before has now 

been modified. 
 

o Create a manipulation object for the sound file: 
o Highlight the newly opened sound file LAB10_laplab.wav in the Praat objects panel. 
o Click To manipulation…  on the right side of the objects panel (keep default settings).  
o This will create a new object in the Praat objects list “Manipulation LAB10_laplab”. 
o In the Praat objects list, highlight “Manipulation LAB10_laplab” and click on Edit in 

the Praat objects panel 
 
à This will open an edit window with three blocks (see Fig. 10.2):  

� The waveform block 
� The pitch manipulation block with the pitch contour as a series of green balls  
� The duration manipulation block.  
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Ignore the pitch manipulation block for this section of the lab and focus on the duration block. 
 

o To insert duration manipulation points in the duration block: 
o Locate the vowel portion in [lap] 
o Insert a duration point at the beginning and end of the vowel (see Fig. 10.2): 

o Place cursor at beginning/end of the vowel 
o Go to Dur > Add duration point at cursor 

o Now insert two additional duration points: one immediately before the beginning of the 
vowel and one immediately following the vowel (during the closure duration of [p] is 
fine). These two points are created to ensure that the remainder of your sound file 
retains its original duration, which will be introduced in detail below. 

 
à You should now have four duration points: 

� pre-vowel (immediately before the beginning of the vowel) 
� vowel-initial (beginning of the vowel)  
� vowel-final (end of the vowel) 
� post-vowel (immediately following the vowel, i.e. following the vowel-final point) 

 

 

waveform 
block 

pitch 
manipulation 
block 

duration 
manipulation 
block 
  

Create a duration point 
at the beginning of the 
vowel. 

Create another duration 
point at the end. 

duration 
level value 
in red 

 
 

Figure 10.2 Manipulation window 
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Dragging the vowel-initial and vowel-final points up will increase the duration of the interval 
(see Fig. 10.2); dragging the points down will have the opposite effect. For example, dragging 
the vowel-initial and vowel-final points to a duration level of 2 will double the length of the 
original selection between the two points (If the vowel was 50ms, the process will change it to 
100ms.) (See Fig. 10.3.) 

 
o To lengthen the vowel: 

o Leave the pre-vowel and post-vowel duration points at the level of 1.000 (they should 
already be there by default. If they are not, drag them to the level of 1.000). You can 
find the duration level value in red at both ends of the red horizontal line. (See Fig. 10.1) 

o Drag the vowel-initial and vowel-end points up as much as you feel is necessary to 
reach the duration of [a] in the natural [lab]. 

o In the manipulation window: File > Publish resynthesis.  
 

à This will put a new sound in the Praat objects panel: SoundfromMapulationEditor 
o Select the file in the object window and Rename: laP2 

 

 
In this example, the vowel-initial point and the 
vowel-final points were both dragged to the level 
of around 2.000, this will almost double the 
duration of the original selection. 

Drag these two points up to 
increase the duration of the 
interval between the two 
points. 

Leave the pre-vowel 
and post-vowel points 
at the level of 1.000. 

 
 

Figure 10.3 Duration Manipulation 



LAB 10 – SPEECH SYNTHESIS 

81 

7. Open this file in the Edit window, and measure the duration of the vowel in labP2. Note 
down your measurement in Table 10.2. 

 
Q3: Compare [laP2] with [laP1] and the original [lab].  

a. Which of your synthesized tokens sounds closer to the natural [lab]?  
b. How natural are these tokens compared to the natural [lab]? Which file ([laP1] vs. [laP2]) 

sounds more natural? 
c. What other manipulations do you think might make it sound better? 

 
 

SECTION II. TONE MANIPULATION 
 
As we discovered in LAB8, pitch contour is used in Mandarin to signal phonemic contrast. In this 
component of the lab, you will transform one Mandarin tone into another one by manipulating its 
PITCH CONTOUR. 
 
8. Follow the instructions below and note down the pitch and duration of the natural T1 and T4 

in Table 10.3. 
 

o Open the sound file LAB10_T1T4.wav in Praat 
o In the Edit window, on the pitch contour, measure the frequency at the start and end of the 

T1 and T4 syllables. Note down your measurements in Table 10.3. If there are some places 
where the tracking function cuts out, use the waveform to measure and calculate the pitch 
(if you can’t remember how to do this, refer to LAB2, p.14). 

o Measure the duration of the natural T1 and T4, respectively and calculate the ratio between 
T1 and T4 (T1/T4). Note down your measurements in Table 10.3. 

 
 

A. Pitch manipulation 
 
9. Follow the instructions below to transform Tone 1 into Tone 4 by manipulating the pitch of 

the sound file. 
o To create a manipulation object of the sound file: 

o Back in the Praat objects panel, highlight LAB10_T1T4. 
o Click To Manipulation…  (keep default settings).  
o This will create a new object in the Praat objects panel “Manipulation LAB10_T1T4”. 
o Highlight this object and click on Edit in the Praat objects panel: this will bring up the 

manipulation window – the same as you saw in 6 above.  
o  
o This time, focus on the pitch manipulation block: 

o Drag the pitch balls to create a new pitch contour: 
o A series of pitch manipulation points have been generated by Praat automatically. 
o Zoom in to T1 
o Drag the first pitch ball of T1 up/down until its frequency is the same as the start point 

frequency of the natural T4 (measured in 8 above; see Table 10.3).  
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o Drag the last pitch ball of T1 down until its frequency is the same as the end point 
frequency of natural T4 (also measured in 8 above). 

o Drag all the balls in between until you get a contour between start and end points that is 
similar to the natural T4 contour. 

o In the manipulation window: File > Publish resynthesis. This will put a new sound in the 
Praat objects panel: SoundfromMapulationEditor. 

o Rename this: SyntheticT4_1 
o Do NOT close the manipulation window at this point. We will come back to this file later. 

 
10. Open the file SyntheticT4_1 in edit window. Measure the beginning and end-point 

frequencies and the duration of syntheticT4_1. Note down your measurements in Table 10.3. 
 

Q4. Compare SyntheticT4_1 with the natural T4. 
a. How close is it to the natural T4? 
b. What else do you think you could do to make it sound more like T4?  

 

 

 

Drag the first pitch ball up 
until its frequency is the 
same as the start point 
frequency of the natural T4 

Drag the last pitch ball 
down until its frequency is 
the same as the end point 
frequency of natural T4 

frequency value 
of the selected 
pitch point 

 
 

Figure 10.4 Pitch manipulation 
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B. Duration manipulation 
 
11. In this section, on the basis of your pitch manipulation, you will change the duration of the 

original T1 to make it more similar to T4. 
o Go back to the tone manipulation window, and identify the original T1 portion. 
o Find the duration manipulation block (the bottom block). 
o Insert four duration points (refer back to Section I, p.79 ): 

� pre-syllable (immediately before the syllable) 
� syllable-initial (at the beginning of the syllable) 
� syllable-final (at the end of the syllable) 
� post-syllable (during the pause following the syllable)5  
 

o Manipulate the duration of T1 so that it resembles the natural T4. 
 
 

TIP 1. Make sure that the pre-syllable and post-syllable duration points are set at the duration 
level of 1.000. They should be there by default.  
2. To lengthen the duration of T1 (see above), drag the syllable-initial and syllable-final 
points up; to shorten it, drag the two points down. 

 
o Listen to the token to see if you are satisfied with the result. Change the duration if you are 

not. 
o Now, to combine the result of pitch and duration manipulations, you can re-save the 

resynthesized file you have created. 
o In the manipulation window: File > Publish resynthesis. This will put a new sound in 

the Praat objects panel: SoundfromMapulationEditor 
o Rename this: SyntheticT4_2 

 
12. Open SyntheticT4_2 in the Edit window: measure the beginning and end-point frequencies 

and the duration of SyntheticT4_2. Note down your measurements in Table 10.3. 
 

Q5: Listen to SyntheticT4_1 and SyntheticT4_2 and compare them to the natural T4:  
a. Which synthesized T4 is more similar to the natural T4? 
b. What can you conclude from the difference between the two synthesized T4s about the 

acoustic cues to tone in Mandarin? 
 
 

SECTION III. RAP SONG 
 
13. As an easy, fun component to this lab, you can record yourself saying a sentence and then 

create a rap song with it by copying and pasting bits here and there. If you do this, e-mail 
your resulting file to sbird@uvic.ca: we can listen to the fruits of your artistic labour in class! 

                                                 
5 See section II B (p. 4) for an explanation of this. 
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LAB 10 – SPEECH SYNTHESIS – WORKSHEET 
 

SECTION I. VOICING MANIPULATION 
 
Table 10.1. VOT manipulation  
 [pa] 

(natural) 
[Pa1] [Pa2] [Pa3] ([Pa4]) ([Pa5]) [ba] 

(natural) 
VOT 
(ms) 

 
 

      

 
Q1. Compare the synthesized [Pa]s you created with the natural [ba]: 

a. Which token sounds the closest to the original [ba], and how close does it sound? 
 
 
 
 
 

b. What other manipulations do you think will be needed to make it more natural? (and how 
would you do these manipulations?) 

 
 
 
 
 
Table 10.2 Vowel length manipulation 
 [lap] (natural) [laP1] [laP2] [lab] (natural) 
Vowel 
Length (ms) 

 
 

   

 
Q2: Compare the synthesized [lap1] you created with the natural [lab].  

a. How close do they sound?  
 
 
 

b. What further manipulation(s) would make the synthesized and natural tokens more 
similar? 

 
 
 

c. What problems do you find with this way of manipulation? 
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Q3: Compare [laP1] with [laP2] and the original [lab].  
a. Which of your synthesized tokens sounds closer to the natural [lab]?  

 
 

b. How natural are these tokens compared to the natural [lab]? Which ([laP1] vs. [laP2]) 
sounds more natural? 

 
 
 

c. What other manipulations do you think might make it sound better? 
 
 
 
 

SECTION II. TONE MANIPULATION 
 
Table 10.3. Tone manipulation.  
 Frequency value 

at the beginning 
point (Hz) 

Frequency value at 
the end point (Hz) 

Duration 
(ms) 

Duration ratio = 
T4 / T1 

T1 (natural)  
 

  

T4 (natural)  
 

  

 

SyntheticT4_1  
 

  

SyntheticT4_2  
 

  

 

 
Q4: Compare SyntheticT4_1 with the natural T4. 

a. How close is it to the natural T4? 
 
 

b. What else do you think you could do to make it sound more like T4? Think about what 
other differences there are between T1 and T4…  

 
 
 
Q5:  Listen to SyntheticT4_1 and SyntheticT4_2 and compare them to the natural T4:  

a. Which synthesized T4 is more similar to the natural T4? 
 
 
 

b. What can you conclude from the difference between the two synthesized T4s about the 
acoustic cues to tone in Mandarin? 

 




